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Chapter 17: Horizontal and Vertical Design 
Introduction 

Since there are many different, and acceptable, methods of creating 
horizontal and vertical geometry using GEOPAK, this chapter will not 
dictate the exact methods to use.  Instead we will describe the different 
methods that can be used and provide a workflow for a macro that will 
check the horizontal alignment design for kinks, once completed.  This 
chapter will be in two sections: Horizontal Design and Vertical Design. 

Horizontal Design 

There are four methods of setting a horizontal alignment: Coordinate 
Geometry (COGO), Graphical COGO, Horizontal Alignment Generator, 
and Store Graphics.  Any of these methods are acceptable to CFLHD.  
Each one of these methods has their advantages and disadvantages, 
since graphical COGO and the horizontal alignment generator are 
similar, we will address these tools together.  This chapter will describe 
each of the above listed methods and indicate their advantages and 
disadvantages.  Regardless of the method used, the final 
alignment must be drawn into MicroStation using the GEOPAK 
D&C Manager, with the CFLHD .ddb file.  This will assure that the 
elements are drawn with the correct symbology, matching the CFLHD 
standards. 

Coordinate Geometry 

Coordinate Geometry can be accessed using Project Manager by 
selecting the Coordinate Geometry button. 

 
Figure 17-1:  Accessing COGO through Project Manager 
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You can also select the Coordinate Geometry button on the GEOPAK 
main dialog box. 

 
Figure 17-2:  Accessing COGO through Road Tools Icon 

If you are using Project Manager, Coordinate Geometry dialog box will 
be invoked.  Otherwise, the Job Number and Operator code will have 
to be entered in the COGO Startup dialog box.  Project Name and 
Subject are optional fields.  Press the OK button to bring up the 
Coordinate Geometry window. 

 
Figure 17-3: Coordinate Geometry 

You can create the horizontal geometry by typing commands in at the 
COGO command line, by creating an input file with a sequence of 
COGO commands and loading it into COGO, or by using the dialog 
box driven Store Curve from Tangents, Locate Traverse, etc., tools 
that are accessed from the COGO pull down menus to generate the 
commands.  If you use the input file method, remember that the COGO 
input file name can only be 8 characters long, must have the job 
number as the last three digits in the name, and the extension has to 
have an “i”+ the operator code.  (i.e. XXXXX101.ijd), where the i 
stands for input file. 

Advantages. 

• This method allows the user to have more precise control over 
tangent bearings, control point coordinates, etc., than with 
Store Graphics, if done properly. 

• The user can set visualization on to view progress of design. 
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Disadvantages. 

• Commands for the command line and input file methods are 
difficult to memorize. 

• Small adjustments are hard to make. 

• Process is time consuming. 

Uses. 

• Reviewing both horizontal and vertical alignments. 

• Creating output of alignments for printing. 

• Tweaking alignments that were created using store graphics, or 
any of the other methods. 

• Storing as-built centerline chain and profiles, especially those 
for which there are only hard copy paper plans. 

Graphical COGO 

Graphical COGO allow the user to create coordinate geometry 
elements using COGO tools with graphic and a user-friendly process.  
Graphical COGO can be accessed by selecting: 

Applications>GEOPAK ROAD>Geometry>Graphical 
Coordinate Geometry  

 
Figure 17-4:  Accessing Graphical COGO  

Or by selecting the icons from the main GEOPAK Road tool dialog 
box. 
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Figure 17-5:  Graphical COGO Icons 

The Graphical COGO tool frame shown below contains tools for 
creating COGO elements such as lines, points, curves, modifying 
COGO elements, manipulating elements, and grouping elements. 

 
Figure 17-6:  Graphical COGO Tool Frame 

From the main Graphical COGO tool frame, shown above, additional 
tools may be accessed from each of the four main tool boxes. 

 

 

 

 
Figure 17-7: Graphical COGO Tools 

 
The Graphical COGO tools shown above, and those 
in the Horizontal Alignment Generator, look and act 
the same as many MicroStation tools.  However, 
these tools are not relying on the accuracy of 
MicroStation graphics, but rather the much more 
accurate GEOPAK coordinate geometry engine. 
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Horizontal Alignment Generator (Element Based) 

Graphical COGO and the Horizontal Alignment Generator, allow the 
user to create coordinate geometry elements, much the same as the 
original COGO tools, but with a much more graphic and user-friendly 
process.   

The Horizontal Alignment Generator can be accessed through the 
Project Manager by clicking on the Horizontal Alignment button on the 
flow chart and selecting Graphical Element Based geometry.  
Horizontal Alignment Generator can also be accessed by selecting: 

Applications>GEOPAK ROAD>Geometry>Layout 
Alignments Horizontal 

Or by selecting third icon in the Horizontal & Vertical Geometry tool 
box.  Selecting this icon will invoke the Horizontal Alignment Generator 
Menu. 

 
Figure 17-8:  Horizontal Alignment Generator  

   

Figure 17-9:  Horizontal Alignment Generator Menu 

The File pull-down menu allows the user to set preferences for how 
newly created elements will be displayed, how to name elements, and 
which geometry tables to use as a default.   CFLHD uses the Spiral 
Design Tables.  To access the Spiral Design Tables, path should be 
set to V8_RESOURCE\X_30\Standards\Bin\english or metric. 
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Figure 17-10:  Horizontal Alignment Generator Preference 

The Design Tables menu allows the user to view the settings for the 
current default design tables.  In the Design Tables pulldown, the user 
sets the paths and file names for the tables to be accessed.  Currently 
CFLHD uses only the Spiral Curve tables (Metric and English).  Once 
the English or Metric Spiral Curve table is selected, select the design 
speed and number of lanes.  These tables correspond with the 
AASHTO Green Book.   

 

Figure 17-11:  Design Tables – Spiral Curve 

The tools menu activates the COGO tools that will be used to create 
geometry elements.  Selecting Tools>Main accesses the following 
tool frame. 
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Figure 17-12:  Horizontal Alignment Generator Tool Frame 

From the main tool frame, shown above, additional tools may be 
accessed from each of the six main toolbox icons. 

 
Figure 17-13:  Horizontal Alignment Generator Tools 

Each of the tool boxes shown above, as well as the tools from 
Graphical COGO, may be used together to create any combination of 
geometry, from the simplest to the most complex. 

Advantages 

• Using these tools to set a horizontal alignment, if done 
properly, is just as accurate as traditional command line 
COGO. 

• The user does not have to remember syntax of COGO 
commands.  
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Disadvantages 

• The Graphical COGO and Horizontal Alignment Generator 
tools can be complicated. 

• The process is slower than using store graphics, as detailed 
below. 

Uses 

• When the geometry is known, as the input of As-Built 
alignments. 

• When the user wants to give exact bearings and distances. 

Store Graphics 

The store Graphics procedure is the simplest and quickest method to 
create a horizontal alignment.  The user can use standard MicroStation 
draw utilities to layout the alignment then use the Store Graphics tool 
to store the alignment into COGO.  Even though MicroStation 
measurements are to single precision, GEOPAK stored elements are 
computed to double precision accuracy.  Store Graphics will make 
slight adjustments to the graphical element locations as required 
forcing each element in the chain to be exactly connected to the 
immediately preceding element and the immediately following element.  
These adjustments are always minor (e.g. the coordinates of a curve’s 
PC and/or PT may be adjusted a few millimeters to force the curve to 
match the tangents exactly) but they do occur and the user has no 
control over them.  However, if the graphical elements were drawn 
correctly then the chain that gets stored into the gpk file is exactly as 
“accurate” as a chain stored using any of the other methods. 

TIP:  Use the filet tool to construct the final curves in the alignment. 
Placing an arc by tangential snap does not always give accurate 
results. 

This command cannot be accessed using Project Manager, but can be 
accessed the following two ways.  From the GEOPAK pull down 
menus select, Applications>GEOPAK ROAD>Geometry>Store 
Graphics 
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Figure 17-14:  Accessing Store Graphics 

Or by selecting the icons from the Geopak Road tool box as shown 
below: 

 
Figure 17-15:  Store Graphics Icon 

Selecting the Store Graphics Icon will invoke the Store Graphics 
Dialog box.  Points, curves, chains and parcels can be stored with this 
dialog box. To store a horizontal alignment, toggle to Chain as shown 
below. Set the Mode to Complex Chain.  Enter the Job number (use 
the magnifying glass to browse to the GPK file), the Operator Code 
(users first and last initial), the name of the chain that will be stored 
and the Beginning Station of the horizontal alignment. 
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Figure 17-16:  Store Graphics 

The Beginning Point of the chain must be a unique point that has not 
been used previously.  To check what points have already been used 
in the project, go to Coordinate Geometry (COGO) Dialog box as 
shown below.  Select Element from the top of the COGO Dialog box. 
Go to Point and then Utility. This opens the Point Utility Dialog box 
which lists all of the points that have been used already.  Points can 
contain numbers and letters. After determining an unused point, close 
the COGO Dialog box (Choose No when the ‘COGO session not 
saved’ Alert appears).  

  

Figure 17-17:  Unique Beginning Point 
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Enter a unique Beginning Point in the Store Graphics Dialog box.  Fit 
the entire horizontal alignment in a View (if a portion of the alignment is 
not in the view, it will not be stored).  Click on the ID Element button.   

 

Figure 17-18:  ID Element 

In the view with the entire alignment, data point the first element in the 
horizontal alignment, the element will then appear highlighted.  Click 
again, and the rest of the elements will be highlighted.  Click again to 
accept the chain, and the Store button will become un-ghosted. Click 
the Store button. Click OK on the Store Graphics Notification. 

 

Figure 17-19:  Store Chain 
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Advantages 

• Use simple MicroStation commands to layout alignment, 
adjustments to alignment are quick, and the only point numbers 
used are on the alignment (usually just the first and last). 

Disadvantages 

• Not as accurate as COGO.  Store Graphics makes minor 
adjustments to the as-drawn elements in order to get them to 
tie together mathematically. 

• Cannot draw spirals using MicroStation commands.  If spirals 
are needed, you must use Horizontal Alignment Generator to 
create that element, and then you may continue using 
MicroStation commands.  

Uses 

• For long alignments with many elements.   
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Horizontal Design – Geopak 2004 

In GEOPAK 2004 there have not been many enhancements to the 
workings of the existing coordinate geometry tools.  The main COGO 
dialog box has been enhanced to include utilities for each type of 
COGO element such as points, lines, curves, chains, etc.  The utility 
dialog box will allow the user to functions such as visualize, print, 
transpose, etc., for each element type.  This allows the user to more 
efficiently work with each type of element independently.  The new 
COGO dialog box, along with some of the utility dialog boxes is shown 
below. 

 

 

Figure 17-20: New COGO Tools 
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Vertical Design 

There are two tools used to set proposed vertical alignments, and both 
are acceptable to CFLHD.  Engineers and designers have used the 
VPI based Vertical Alignment Generator since the early days of 
GEOPAK.  This tool, although having been around for years is still a 
user-friendly, accurate method for creating and storing vertical 
alignments.  The second method is the Component Based Vertical 
Alignment Generator.  This tool has been updated and improved over 
the VPI based tool, and has yet to be fully utilized by most GEOPAK 
users.  Both these methods are just as accurate and depending on 
your preference, as easy to use.    There are two methods available for 
creating and storing an Existing Ground profile; Traditional method and 
the new Draw Profile Tool method. 

Existing Ground Profile 

Once a run is created for the working alignment, the existing ground 
profile should be cut and drawn using the D & C Manager.  CFLHD’s 
traditional method for cutting existing ground profile is shown below.  
Existing Ground Profile can be accessed through the Project Manager 
by selecting the Existing Ground Profile button. 

 

Figure 17-21:  Accessing Existing Ground Profile through Project 
Manager 

The Existing Ground Profile dialog can also be accessed by typing in 
mdl load ex_prof command in the MicroStation Key-in box. 

 

Figure 17-22:  MicroStation Key-in 
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The following Existing Ground Profile dialog box will appear. 

 

Figure 17-23:  Traditional Existing Ground Profile  

Enter in the required information and select Apply.  Apply will cut your 
existing ground profile for the chain and store it into the GPK file.  
Existing ground profile can be accessed and drawn into MicroStation 
using the Geopak D & C Manager, with the CFLHD .ddb file.  This will 
assure that the existing ground profile is placed with the correct 
symbology. 

Draw Profile Tool - GEOPAK 2004 

New to GEOPAK 2004 is a streamlined way to create existing ground 
profiles, and plot both existing and proposed profiles.  The Draw 
Profiles tool is not available through project manager workflow dialog 
box, but can be accessed by selecting Applications>GEOPAK 
ROAD>Plans Preparation>Draw Profiles 
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Figure 17-24: Select Draw Profiles 

 

The Draw Profiles tool may also be accessed from the Plans 
Preparation tool palette as shown below. 

 
Figure 17-25: Draw Profile Icon 

 

All that is needed for this tool is a horizontal alignment and a .tin file.  
This tool allows for the creation of an existing ground profile in much 
the same way as the Traditional method, but does so behind the 
scenes, with increased efficiency and a much cleaner workflow.  This 
tool also allows the user to draw profiles into MicroStation using the 
D&C Manager .ddb settings ensuring adherence to the CADD 
standards.  Also, with the Draw Profiles tool, there is no need to delete 
before re-drawing updated profiles. 
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Workflow 1:  Creating an existing ground profile using 
Draw Profiles Tool 

1. Select the Draw Profiles tool using one of the methods described 
above. 

2. Select the job number where the chain is stored and the 
associated chain. 

3. Select the Dialog Profile Cell Control icon located to the right of 
the job number. 

  
Figure 17-26: Draw Profile Dialog Box 

 
4. The dialog box below will appear.  Select the Place Profile Cell 

icon on the top right side of this dialog. 
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Figure 17-27: Profile Cell Control 

 

5. Once selected the following dialog box is activated allowing the 
user to set the station and elevation for the origin of the profile, 
set the horizontal and vertical scale, and set the top and bottom 
ranges for the cell.  Elevation and Cell Range should match the 
range of Z value for your project.   Notice how similar this dialog 
looks to the D&C Manager dialog for placing a profile cell. 

 

 
Figure 17-28: Place Profile Cell 

 
6. Once this dialog box has been populated, the user may place the 

cell where desired.  The Profile Cell Control dialog box will now 
be populated. 

 
Figure 17-29: Profile Cell Control 

 
7. Dismiss the Profile Cell Control dialog box and return to the Draw 

Profile dialog.  Notice that before placing the profile cell 
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everything below the chain name on this dialog box was grayed 
out. 

8. This dialog box is now active and the user is now able to populate 
the Surfaces and COGO tabs. 

9. Begin by selecting the correct .tin file.  Once the .tin file is 
selected the user must now decide how to cut the existing ground 
profile.  The options shown above; Triangles, Break Lines, POT, 
Increment, and Even, are the same options allowed in the original 
Ground Profile tool.  Select the Triangles option. 

 

 
Figure 17-30: Draw Profile Method 

 

10. Next the user must tell GEOPAK how to draw the profile with the 
correct symbology.  Previously, the user would use the D&C 
Manager exclusively to accomplish this.  The Draw Profile tool 
will use either the D&C Manager or allow the user to input the 
level symbology.  Select By Feature to access the D&C Manager. 
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Figure 17-31: Display Settings 

 

11. Once selected, the paintbrush becomes active.  Click on the 
paintbrush to access the D&C Manager. 

 
Figure 17-32: D&C Manager 
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12. Select the correct element as shown above, 
CHAINS/PROFILES>CFL/EFL>EXPROF Existing ground profile.  
Select the OK button in the upper right hand corner of the dialog 
box. 

13. Once the dialog box has been populated with the correct .tin file, 
the method, and the symbology, select the Add Surface Settings 
icon, circled below. 

 

 
Figure 17-33: Add Surface 

 

14. Selecting the Add Surface Settings icon will populate the surface 
into the dialog box and instantly draw the profile onto the 
previously drawn profile cell. 
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Figure 17-34: Store Surface in COGO 

 

So far this workflow has allowed us to create the existing ground 
profile and draw it into MicroStation with the correct symbology.  In the 
continuation of this workflow, we will store the profile into COGO and 
plot more information such as elevation and station labels, along with 
anything else that was previously available to be plotted from the D&C 
Manager. 

15. To Store this profile into COGO, select the Store Surface in Cogo 
icon, as shown above.   

16. The store profile dialog box will appear.  Populate the Profile 
Name box with the desired name.  Check the box labeled Store 
Profile in GPK.  Select Apply. 
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Figure 17-35: Store Profile 

 

17. The profile is now stored in the GPK.  Dismiss the Store Profile 
dialog box and return to the Draw Profile dialog box. 

18. Select the COGO tab and from the Profile Name box, select the 
correct profile. 

 

 
Figure 17-36: Draw Profile Dialog Box 

 

19. Under the options section, located in the bottom quarter of the 
dialog box, select General. 
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Figure 17-37: Profile Options 

 
20. This allows the user to select the Axis labels and the Strip Grade 

Increment, if desired.  The additional options are shown below. 
 

 
 

 
Figure 17-38: Profile Options 

 
21. From the options shown above the user has the same flexibility in 

drawing the profile into MicroStation as the D&C Manager.  Once 
the desired options have been selected, click the Add Cogo 
Profile Settings icon, as shown below, and the profile will be 
complete.  Multiple profiles can be drawn using the COGO tab. 
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   Figure 17-39: Profile Drawn into MicroStation 

The projection tab can be used when the chain and profile that needs 
to be drawn is different than the chain and profile used to create the 
profile cell. 

 
           Figure 17-40: Profile Projection Tab 
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Proposed Vertical Alignment 

The VPI based Vertical Alignment Generator is the traditional method 
used by CFL designers in creating vertical alignments.  Vertical 
alignment generator can be accessed through Project Manager by 
selecting the Vertical Alignment button. 

 

Figure 17-41: Accessing Vertical Alignment through Project Manager 

The VPI Based Vertical Alignment Design Tool may also be accessed 
from the Horizontal & Vertical Geometry tool palette as shown below. 

 
Figure 17-42: VPI Based Vertical Alignment Icon 

Selecting the VPI Based Vertical Alignment Design Tool will invoke the 
dialog box below: 
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Figure 17-43: VPI Based Vertical Alignment Settings 

Once the settings are defined, selecting OK will invoke the GEOPAK 
Profile Generator.   

 

Figure 17-44: Profile Generator 

For US Customary projects, the User Preferences are as shown 
below:   

 
   Figure 17-45: User Preferences 
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If the project requires the use of Maintaining K value instead of 
Maintain VC Length, commonly used, attach the correct K-Value table.  
K Value Table can be accessed by selecting User>K-Values. The 
following dialog will appear: 

 

Figure 17-46: K-Value Table 

Use File>Open to attach the correct unit K-Value table (.kvl).  K-Value 
table can be attached from V8_RESOURCE\X_30\Standards\Bin\ 
english or metric. 

After the proposed vertical alignment is created and saved, use the 
Draw Profile Tool or the D&C Manager to drawn profile in MicroStation, 
ensuring adherence to the CADD standards.  For CFLHD projects, the 
toggles shown below must be selected prior to drawing the profile. 

    

Figure 17-47: D & C Manager to Draw Profile Draw 
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Workflow 2:  Creating Proposed Vertical alignment 
using Component Based Vertical Alignment Design 
Tool 
The new method to create vertical alignment introduced with     
Geopak 2000 is the Component Based Vertical Alignment Design 
Tool.  This method allows for vertical alignment to be created 
graphically and stored using Store Graphics command, similar to the 
horizontal alignment Store Graphics command.  The Component 
Based Vertical Alignment Design Tool requires COGO to be active as 
well as an Active Chain and Active Profile Cell.  Component Based 
Vertical Alignment Design Tool requires the use of Active Chain 
Control, a method introduced with Geopak 2000.  Active Chain Control 
can be used in place of the 3 port viewer.  

1. Select the Active Chain Control tool by Selecting 
Application>Geopak Road >Active Chain Control 

 
Figure 17-48: Accessing Active Chain Control 

Or by selecting Active Chain Control button from the Geopak Main 
dialog box.   
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Figure 17-49: Accessing Active Chain Control through Road Tools Icon 

Selecting the button will invoke the Active Chain Control dialog. 

 
Figure 17-50: Active Chain Control Dialog 

2. Using the Active Chain Control dialog box, eight MicroStation 
view are available to set the graphical data for Plan, Profile and 
Cross Section.   In the dialog box shown below, View 1 is the plan 
view, View 2 is the profile view and View 3 is the cross section 
view.  To use the Component Based Vertical Alignment Tool, 
assign your profile to a view by right clicking on one of the eight 
MicroStation views and selecting the Profile. 

 
Figure 17-51: Assigning Profile View 

3. Select the Component Based Vertical Alignment Tool by Selecting 
Application>Geopak Road >Geometry>Layout Profiles 
(Component Based) 
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       Figure 17-52: Accessing Component Based Vertical Alignment Tool 

Or by selecting Component Based Vertical Alignment Tool from the 
Geopak Main dialog box.  Component Based Vertical Alignment Tool 
is not available through the Project Manager Workflow dialog box.  

 
Figure 17-53: Accessing Component Based Vertical Alignment Tool 

through Road Tools Icon 

4. Once selected the main Component Based Vertical Alignment 
Tool frame is activated as shown below.  The tool frame contains 
tool boxes to place vertical alignment lines, manipulate vertical 
alignment elements, place vertical alignment curves and profile 
tools.  

 
Figure 17-54: Component Based Vertical Alignment Tool Frame 

5. From the main Component Based Vertical Alignment Tool frame 
shown above, following additional tools can be accessed from 
each of the four main tool boxes.  
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Figure 17-55: Component Based Vertical Alignment Tools 

6. Prior to using the Component Based Vertical Alignment Tools to 
draw, select the Dialog Graphical Profile Preference icon as 
shown below. 

 

 
Figure 17-56: Dialog Graphical Profile Preferences 

7. Set the Element Symbology for the Line and Curve.  Setting the 
element symbology will allow for easier viewing when designing 
the vertical alignment using the Component Based Vertical 
Alignment Tools. 

 
Figure 17-57: Graphical Profile Preferences 

8. Use the Component Based Vertical Alignment Tools to 
graphically draw the vertical alignment. 
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Figure 17-58: Draw Graphical Profile  

9. Once the vertical alignment is drawn using the Component Based 
Vertical Alignment Tools, vertical alignment can be stored.  Select 
Store Vertical Alignment icon from the Profile Tools dialog to 
store the vertical alignment. 

 
Figure 17-59: Store Vertical Alignment Icon 

10. Once the Store Vertical Alignment icon is selected, the following 
dialog will activate if the COGO dialog is not already activated.  
Select OK.  The Component Based Vertical Alignment Tools 
requires COGO to be active. 

 
Figure 17-60: COGO Activation 

11. Selecting Store Vertical Alignment icon will activate the following 
dialog box.  Input the profile name and select the elements to 
store. 

 
Figure 17-61: Store Vertical Alignment 

 

The various methods for creating horizontal and vertical geometry 
using GEOPAK are describe in this chapter.  Regardless of the 
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method used, the final alignment and profile must be drawn into 
MicroStation using the GEOPAK D&C Manager, with the CFLHD .ddb 
file.  Workflow 3 outlines a macro used at CFLHD to check the 
horizontal alignment design for kinks. 

 

Workflow 3:  Macro - Checking for Kinks in Horizontal 
Alignment 
The Check Bearing Macro checks a GEOPAK COGO "describe chain" 
output file for kinks in the alignment by comparing AH and BK bearings 
of consecutive chain elements.   

1. Select Coordinate Geometry from the Project Manager 
Workflow dialog box as shown below. 

 

 
Figure 17-62: Accessing COGO through Project Manager 

2. To describe a chain, Select  Element>Chain>Utility from the 
COGO dialog box. 
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Figure 17-63: Accessing Utility Dialog box 

3. In the Chain Utility dialog box, select the chain you want to 
describe and Click on the Describe Icon shown. 

 
Figure 17-64: Chain Utility Dialog box 

4. COGO dialog box will be populated with the chain described 
as shown below.  Create an Output File by selecting 
File>Input File Utility from the COGO dialog box. 

 
Figure 17-65: Accessing Input File Utility 

5. In the File Utility dialog box, Select output from lower left pull 
down and type in a name for the Output File.  Select apply to 
create an Output File.  Output File for the example is named 
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main101.ojd.  101 is the job number, O for output, JD is the 
user initial. 

 
Figure 17-66: File Utility 

Once an output file is created describing the chain, the Check Bearing 
Macro can be used to check for kinks in the alignment. 

6. To run Check Bearing Macro, Select Utilities>Macro 
>MicroStation Basic from the main MicroStation pulldown 
menu.  

 
Figure 17-67: Accessing MicroStation Basic 
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The following dialog will appear: 

 
 Figure 17-68: MicroStation Macro 

7. Browse to select chkbear.ba macro from the list of macros.  
Select the macro and the Start Macro dialog box will appear 
as shown below.  Click on the Run button. 

Macros are located in V8_RESOURCE\X_30\Standards\Macro\ 

 
Figure 17-69: Start Macro 

8. Running the macro will invoke the following dialog box.  
Select the COGO Output File created for your alignment and 
select OK. 

 
Figure 17-70: Select COGO Output File 
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9. Selecting the COGO Output File will invoke the Check 
Bearings dialog box.  In the Check Bearing dialog box toggle 
1 second and select OK. 

 

 
Figure 17-71: Check Bearings 

User sets tolerance for bearing comparison in the check bearing dialog 
box (i.e., how much do the bearings need to differ before they are 
flagged as a kink).  

10. Results to the macro run are reported the on screen, as 
shown below, and in the log files chkbear.log and chkbear.err.  

 

 

Figure 17-72: Check Bearings Error 

If the macro run, reports mismatched bearing errors; user must correct 
the error and restore the horizontal alignment.  Workflow 3 should be 
repeated till no mismatched bearing errors are found. 
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Related links:   Using Knucklehead’s Guide for GEOPAK Road 2004 
Edition. 

To Create the Horizontal Alignment  

Generate the Existing Ground Profile  

To Create the Vertical Alignment  

http://www.wfl.fha.dot.gov/geopak/idiot2004/cre_ha.htm
http://www.wfl.fha.dot.gov/geopak/idiot2004/gen_e_pr.htm
http://www.wfl.fha.dot.gov/geopak/idiot2004/cre_va.htm
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